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Catalog Administration
A guide to creating and managing Catalogs
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A Note on Catalog Terminology

The Examples in this document may use Cata-
logue, Catalog or Campaign.

The name of this component may be personal-
ized for your company - please contact Mtivity 
Support to make this change.
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Accessing Mtivity
Mtivity can be accessed from any web browser con-
nected to the internet. 

www.mtivity.com/DcLogin.csp

Custom login pages can also be created - see 
Zendesk Forums > Guides and Documentation for 
details

Navigation
Once inside the system, you will see two main areas 
of Navigation.

Section Navigation

Tabs

Getting Started

Section Navigation shows which main area of Mtivity 
you are in - the main sections you will use are; 

Admin - This is where your catalogs can be cre-•	
ated and managed

Dashboard - This is the consolidated data across •	
all jobs 

Job Bag - When you are in this section the data •	
you are viewing is for the selected job only. 

Personal Setup - This contains your personal •	
settings and preferences, this is where you go to 
change your password or username

Tabs will change to reflect the objects available within 
each section.  So, for example, once you click on the 
admin section, you will see the Catalog tab become 
available. The bar above the selected tab indicates 
your current location.

Roles & Licenses
To administer catalogs you should be assigned the 
following licenses:  

Professional User License•	

Catalog Manager License•	

If you can’t see the Admin section or the Catalogs 
tab, you do not have the correct role or license - con-
tact your company administrator who will be able to 
assign you the appropriate permissions.

Support
Mtivity’s support desk is available from 09:00 AM to 
17:30 PM, Monday - Friday (excl. public holidays).

Telephone•	 : +44 (0)20 7397 2910 (UK)  
    1 (585) 200 3151 (USA)

Email•	 : support@mtivity.com

Skype•	 : mtivity.support
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Items

An Item can be considered as a product, or piece of 
print that your client can order. There is no restriction 
on what sort of products may be ordered, for exam-
ple, Mtivity currently contains items as diverse as bro-
chures, business cards, promotional objects such as 
key rings or caps, videos, and downloadable logos.

There are three ‘types’ of item within Mtivity - each 
with a different purpose;

Downloadable•	  - this allows your clients to down-
load the item at no cost. These items are generally 
used for electronically distributed collateral and 
brand assets.

From Stock •	 - this will generally be fulfilled from a 
warehouse of pre-printed stock with no produc-
tion activity required.

Make to Order•	  - this will usually need to go 
through a production process such as printing. 
These items may also be personalized by your 
clients if needed.

Book•	  - this is a group of PDFs (chapters) from 
which the client can select applicable ones. The  
system will then compile these into a ‘book’, 
which goes through the production process. If  
you would like to enable Book Items for your  
company, please contact Mtivity Support.

 

Components of an Item

An Item will generally need to contain two other 
components:

File - This is the print template, or if not for print, 
the visual representation of the item

Pricing - An item’s pricing is managed through 
materials, these then need to be selected when 
creating your item. This allows pricing details to 
be re-used by multiple items.

Pricing
An item’s pricing is managed through materials - in 
addition to the cost, a material also contains informa-
tion on who supplies the material, what quantities it’s 
shipped in, and what the delivery time is. A material 
or group of materials are linked to items through their 
respective Item Pricing sections.

Once an order is placed by your client, each material 
will be directed to its supplier in the form of a Pur-
chase Order and Production Activity. If one vendor 
supplies multiple items (materials) from an order, these 
will be amalgamated into a single Purchase Order and 
Production Activity. 

Multiple pricing options may be defined against Items, 
from which one can be selected by your client when 
ordering the Item. This can be used to allow your 
client to select a variation of an Item - for example 
a size, production method, finish or stock. As each 
variation may have different materials the price will 
update according to the option selected by the client. 

Creating Materials 

Location: Admin > Organization > Materials

From the Materials page, click New in the Tools 1. 
menu on the right hand side.

From the Type menu, select Standard if your 2. 
supplier is a third party, or Internal Supply if it is 
produced internally.

Creating Files, Pricing and Items
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The Name and Description will display to the sup-3. 
plier - your client will not see this information.

The Margin is a percentage increase that will be 4. 
applied to the material’s cost. Your suppliers will 
see the cost price in their purchase orders and 
your clients will see the cost price plus margin 
when ordering an Item.

Select the Sales Tax that will be applied5. 

The Lead Time is the number of days that the Ma-6. 
terial will take to be produced. This displays to the 
Client when they order the Item that contains this 
Material. Mtivity is working day aware, so week-
ends are not counted in the estimated delivery 
dates.

From the Suppliers section on the right hand side, 7. 
click the Contact Selection Tool ( ) to select the 
vendor. If you wish to give your client a choice 
from a set of vendors, you can select multiple 
contacts.

The Pricing Details section at the bottom of the 8. 
screen  allows you to input a quantity and cost 
matrix. Once the Material is associated with the 
Item, these are the quantities and prices (plus 
Margin) that your client will be able to order. See 
Pricing Examples below for more information.

When you’re done, click Save9. 

Pricing Examples

Here your client will only be able to order one of three 
quantities - 100, 200 or 300, costing $1000.00, $2000.00, 
and $3000.00 respectively.

In this example, a Run On of 100 has been entered. This 
means that your client is able to order any quantity of items 
in multiples of 100. Because the first Quantity is 100, that is 
the minimum orderable amount, there is no maximum.  

This example is the same as above except that a maximum 
orderable quantity of 10000 has been set.

Pricing Examples Continued

This example is the same as the first except the Shipping 
column has an entry for each Quantity band. This is a fixed 
fee that is applied to each order, so for example, if 100 
were ordered this would cost your client the $1000.00 
from the Cost column, plus the $50.00 from the Shipping 
column, totalling $150.00.

This is a Flat Rate Material, It is typically used as a ‘per 
order cost’ in conjunction with a standard Material. When 
you associate Materials to an Item, you are able to select 
one standard Material and an unlimited number of Flat Rate 
Materials.

Adding Materials to Items 

Location: Admin > Catalogs > Items

From the New/Edit Item page, scroll down to the 1. 
Item Pricing section. There will always be a ‘Stan-
dard’ option (unless this has been changed by 
your Catalog Manager).

Click the Select Materials link, this will open the 2. 
materials Selection Tool. 

Select the material you wish to associate with the 3. 
item by moving it to the Primary Material box on 
the right hand side. A primary material will dictate 
the quantities available to order. If no additional flat 
rate materials are added this will also define, the 
total cost, lead time and supplier of the item.
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You may associate any additional flat rate materi-4. 
als by moving them to the Flat Rate Materials box 
on the right hand side. You will be able to define 
Qty options for the flat rate materials when you 
return to the item screen. See Flat Rate Units for 
more information.

Click OK to close the window and return to the 5. 
item screen.

Flat Rate Units

Below shows an item’s pricing with 4 materials 
added. Folder Packs is a qty based primary ma-
terial, this means that it will dictate the quanti-
ties that may be ordered by your client. Sticker, 
Paper and Shipping are three flat rate materials 
that will also be added to any orders for this item

 

The price for Sticker Insert is set to be applied once for 
the qty of items ordered. So if the price for a sticker was 
5 cents and 10 packs were ordered, 50 cents would be 
added to the cost of the order.

The price for Paper is set to be determined by the page 
count of the item. So if the price for Paper is 2 cents and 
the item is 10 pages long, 20 cents will be added to every 
item ordered.

Finally, Shipping is set to be applied once to the order, 
regardless of how many items are ordered. 

Adding Multiple Pricing Options to an Item

Location: Admin > Catalogs > Items

You can offer your client a choice of variations on 
price by creating multiple options in the Item Pricing 
section. If more than one option is defined, your cli-
ent will be able to select one from a dropdown menu 
when ordering the Item.

From the New or Edit Item page scroll down to 1. 
the Item Pricing section.

Click the Add Pricing Option button.2. 

This will open the Add Pricing Option window.3. 

Give the option a Name, this is what will appear 4. 
to your client in the dropdown menu. If you intend 
to reuse a particular pricing option across multiple 
items, you can create it in the Pricing Options sub 
tab - options created there are available for use on 
all items.

Click the Select Materials link to add a material to 5. 
the option. 

Click the OK button to create the option.6. 

The Default checkbox to the left of the options will 7. 
ensure that the selected option is pre-selected 
when the client browses the catalog.

A Client’s View of Pricing Options

Below is how your client would view an Item 
with multiple Pricing Options.

The Pricing Options will appear above the Qty selection 
area. In this example the Pricing Option has been given a 
label  of ‘Variation’
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Setting Reusable Pricing Options 

Location: Admin > Catalogs > Pricing Options

You can set default Materials and/or options on new 
Items by adding these in the Pricing Options sub tab. 
Settings defined here are automatically applied to all 
new items (although they can be deleted or changed 
when creating the item). This saves you having to 
select Materials or add options every time you create 
an Item.  

Go to the Pricing Options sub tab in the Catalogs 1. 
area. This displays your default pricing that is used 
for all new Items. All companies will have a ‘Stan-
dard’ option.

Click the Edit link next to the Standard Item. This 2. 
will take you to the Edit Pricing Option screen.

Here you can select the Material(s) that you wish 3. 
to be automatically applied to all new Items.

You may also change the name of the option, 4. 
but this will only be seen by the client if they can 
select from multiple Pricing Options.

When done, click the Save button.5. 

Note: From this screen you can also create new Pric-
ing Options which can be set to be added by default 
to all new Items. Use the Add By Default checkbox to 
ensure your options are pulled through automatically, 
if you do not wish them to be added by default, they 
will still be available for selection from the new Item 
screen. 

Changing the Label of Pricing Options 

Location: Admin > Catalogs > Pricing Options

If you intend to offer your clients the option of select-
ing a variation when ordering an item, you may want 
to change the label that appears to them (see A Cli-
ent’s View of Pricing Options above ). 

In the Pricing Options sub tab, you will see a pref-1. 
erences box at the top of the page.

Click the Edit link, this will change the Preferences 2. 
to edit mode.

Here you can enter the Pricing Options Label that 3. 
will appear to your clients. Selecting Always in the 
Show In Catalogues setting will display this label 
along with the Item Pricing Name for ALL items 
(even if selection is not available).

Click the Save button to commit your changes.4. 

Note: At this stage the Pricing Option label applies 
to all Items that use multiple pricing, but this will be 
updated in the future to allow the label to be set at 
an Item level. In the meantime, Mtivity suggests using 
something generic such as ‘Variation’ or ‘Option’.

Files
The Primary File is the basis of an item, it can also be 
thought of as a template. If the Item type is Stock or 
Make to Order, it is the file that is passed on to the 
printer - this must be a PDF. If the item type is Down-
load, it is the file that your client downloads - this can 
be any file type. All items must have a Primary File.

Uploading Files

Location: Admin > Catalogs > Files 

Click New in the Tools menu on the right hand 1. 
side. This will open the New File window.

Select your client - this will help when locating files 2. 
later.
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Click the Browse button on the File field, this will 3. 
allow you to select the file you wish to upload.

You can add multiple files by clicking the Add An-4. 
other file button, or just click Save to start upload-
ing.

Once your file has uploaded it will be available for 5. 
selection immediately but the automatically cre-
ated thumbnail and preview images may take a 
few seconds to render.

Importing Multiple Files From Zip

Location: Admin > Catalogs > Files 

Click Import from Zip in the Tools menu on the 1. 
right hand side. This will open the Select Zip File 
window.

Click the Browse button on the Zip File field, this 2. 
will allow you to select the file you wish to upload. 

Select your client - this will help when locating files 3. 
later.

Click Next to proceed to the next step. 4. 

The system will scan the zip file and detail the files 5. 
to be uploaded. Once you have confirmed these 
are the files you wish to upload, click the Upload 
Now button.

Finding Files

At the top of the File listing page you will see 
a View menu. Try creating a new View or edit-
ing an existing one as a more efficient way to 
browse your files - for example, you can edit a 
View to only show files of a particular type.

Bulk Import of Files

Location: Admin > Data Management

It is possible to bulk import Catalog Files using FTP 
and CSV import. The files that you want to import can 

be placed in your FTP folder, and the full FTP location 
can be specified in the CSV file. 

You may also bulk delete or edit details of files with 
the CSV Import function.

To set up a FTP folder for your company please con-
tact Mtivity Support. 

Downloadable Items
A Downloadable Item has no production process or 
cost associated with it. It is generally used to allow 
client’s to download brand assets, guidelines and 
documentation instantly.

Creating a Downloadable Item

Location: Admin > Catalogs > Items

Click New Download Item in the Tools menu on 1. 
the right hand side. This will open the New Down-
load Item screen.

The Name will appear to your clients so call it 2. 
something that they will understand.

If you have a unique code for this Item you can 3. 
enter it in the item Code field. Your clients can 
search on this code too.

If you want to add some more information about 4. 
this Item you can do so in the Description field - 
your clients will be able to see this.

Click the Selection Tool (5. ) on the Primary File field 
to select the file that your client will download. 
Notice how the Thumbnail automatically updates? 
If you wish to change this, click the Change link 
and select another file.

The Preview setting allows your client to view a 6. 
preview PDF of the Primary File in their browser.

Its generally a good idea to select your client from 7. 
the Client menu - this makes objects easier to find 
later.

If an item is set to non-active, it does not display 8. 
to your client, this is a handy way of taking an item 
offline if changes need to be made.

You can make multiple files available for your client 9. 
to download by selecting Associated Files. To do 
this click the Selection Tool ( ), select your files, 
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then make sure the Client Visible checkbox is 
ticked. 

If you wish to associate Metadata with your Item 10. 
you can do so here - see the Metadata section 
below for more information.

Click the Save button to create your Download-11. 
able Item.

A Client’s View of a Downloadable Item

Below is how your client would view a Down-
loadable Item when browsing their Catalog.

Thumbnail

This is how your 
client downloads 
the Item

Size and type of the 
Primary File. If multiple 
files are available, this 
will display a count

Name Description

Stock Items
A Stock Item is generally fulfilled from a depository 
such as a warehouse, unlike a Downloadable Item it 
must have a Material associated with it.

Creating a Stock Item

Location: Admin > Catalogs > Items

Click New Stock Item in the Tools menu on the 1. 
right hand side. This will open the Stock Item 
screen.

The Name will appear to your clients so call it 2. 
something that they will understand.

If you have a unique code for this Item you can 3. 
enter it in the Item Code field. Your clients can 
search on this code too.

If you want to add some more information about 4. 
this Item you can do so in the Description field - 
your clients will be able to see this.

Click the Selection Tool (5. ) on the Primary File 
field to select the PDF or artwork that your client 
is ordering. Notice how the Thumbnail automati-

cally updates? If you wish to change this, click the 
Change link and select another file. If you have a 
File Reference Number you can input that instead 
of selecting a file. 

The Preview setting allows your client to view a 6. 
preview PDF of the Primary File in their browser.

You can enter your stock information now - initially 7. 
all items will have zero stock, you will need to add 
stock after saving the Item.

Once the stock level reaches a the Restock Alert 8. 
Qty you can send an alert - this is an email that 
gets sent to your supplier and/or manager detail-
ing the stock levels. If you enter a Restock Order 
Qty, this will be included in the alert email request-
ing restocking.

Restock Lead Time is the number of days it will 9. 
take to replenish your stock. If Back Orders are 
allowed this will be added to give your Client an 
estimated delivery date.

Display Stock Level will show the current stock 10. 
levels to your clients. If you have this set to No, 
your client will simply see a ‘In Stock’ message.

Back Orders allow your clients to place orders for 11. 
the item even if it is out of stock. If Back Orders 
are allowed, the Restock Lead Time will be added 
to the Material’s Lead Time to give your Client an 
Estimated Delivery Date.

You can allow Reservations for Stock Items - this 12. 
will enable your clients to reserve the item in their 
order basket for the set number of hours, which 
will deduct the ordered quantity from the available 
stock.

If your materials have multiple suppliers associ-13. 
ated with them, you can let your client select one 
when placing their order.

Delivery Date Amendment will allow your client to 14. 
request an earlier delivery date. When an Order is 
placed, the Purchase Order will go through to the 
supplier with the newly requested date, your sup-
plier will have the opportunity to accept or decline 
the PO.

A Job Ticket will usually be sent in plain TXT for-15. 
mat, however, If your supplier is JDF enabled you 
may choose to use JDF formatted tickets.

After your client places an order, a Purchase Order 16. 
is created. This must be sent and accepted for the 
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job to progress. Some companies prefer to send 
this manually as a final check, but most prefer this 
to be done automatically as human intervention 
tends to slow the process down. Mtivity recom-
mends applying a Workflow to the Catalog as a 
whole - this can be set to Send and Accept Pur-
chase Orders automatically and saves having to 
make these settings on an individual Item level. A 
Workflow will override the Purchase Order settings 
made at an Item level.  

Its generally a good idea to select your client from 17. 
the Client menu - this makes objects easier to find 
later.

If an item is set to non-active, it does not display 18. 
to your client, this is a handy way of taking an item 
offline if changes need to be made.

Select your Item Pricing to define the Item’s pric-19. 
ing, estimated delivery date, available quantities 
and supplier. See the Pricing section above for 
more information.

Associated Files can be passed on to your clients 20. 
and suppliers. This is usually used for original or 
supporting documents. To do this click the Selec-
tion Tool ( ) and select your files. 

If you wish to associate Metadata with your Item 21. 
you can do so here - see the Metadata section 
below for more information.

Click the Save button to create your Stock Item.22. 

A Client’s View of a Stock Item

Below is how your client would view a Stock 
Item when browsing their Catalog.

NameThumbnail Description Item Code

Stock Level

Lead Time (from the 
Item’s Material)

This is how your client 
orders the Item

Qty and price details 
(from the Item’s Material)

Adding Stock 

Location: Admin > Catalogs > Items > Stock Item

Click the Add Stock link next to the In Stock field. 1. 
This will open the Add Stock window.

Enter the amount of stock you want to add 2. 

If necessary, you may also add a Reference and 3. 
any Notes.

Click the Save button to add your stock.4. 

Adjusting Stock 

Location: Admin > Catalogs > Items > Stock Item

Click the Adjust Stock link next to the In Stock 1. 
field. This will open the Adjust Stock window.

If you are adding Stock, enter the adjustment in 2. 
the Stock In field, if you are subtracting, use the 
Stock Out field.

When adjusting stock it is mandatory to leave a 3. 
Note or reason for the adjustment.

Click the Save button to make the adjustment.4. 
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Viewing Stock Adjustments 

Location: Admin > Catalogs > Items > Stock Item

When viewing a Stock Item’s details page, the Adjust-
ments table will display all Stock In and Out calcula-
tions. 

Export/Import Stock Levels

Location: Admin > Data Management 

In the Data Management area you can export a CSV 
of your current stock levels across all Stock Items. 
You can also use the import function to update stock 
levels, this saves you having to manually navigate to 
each Item to make changes.  

Copying Items

It is often more convenient to make a copy of 
an existing Item rather than creating a new one 
from scratch.

To do this, simply edit the Item you wish to make 
a copy of, change the name (as well as any 
other details) then click the Save as New button.

This will also copy any customizations that have 
been created.

Save as New will 
create a copy

Make to Order Items
A Make to Order Item will usually need to go through 
a production process such as printing. These items 
may also be personalized by your clients if needed.

Creating a Make to Order Item

Location: Admin > Catalogs > Items

Click New Make to Order Item in the Tools menu 1. 
on the right hand side. This will open the new 
Make to Order Item screen.

The Name will appear to your clients so call it 2. 
something that they will understand.

If you have a unique code for this Item you can 3. 
enter it in the Item Code field. Your clients can 
search on this code too.

If you want to add some more information about 4. 
this Item you can do so in the Description field - 
your clients will be able to see this.

Click the Selection Tool (5. ) on the Primary File 
field to select the PDF or artwork that your client 
is ordering. Notice how the Thumbnail automati-
cally updates? If you wish to change this, click the 
Change link and select another file. If you have a 
File Reference Number you can input that instead 
of selecting a file. 

The Preview setting allows your client to click the 6. 
thumbnail to view a preview PDF of the Primary 
File in their browser.

The Printing setting is passed onto the supplier in 7. 
the Job Ticket - this is just used for information, it 
will not make any alterations to the PDF artwork.

When your client is placing their order for this Item 8. 
you can set whether they can upload a file, this 
can be used for a variety of purposes such as a 
translation file or list of addresses to send the out-
put to. The Send to Supplier checkbox will ensure 
that the vendor also has access to the uploaded 
file.

You can select whether to allow your clients to 9. 
download the customized PDF, if so, you can se-
lect further Adobe Acrobat security settings such 
as allowing editing, printing, password protection, 
or stamping the PDF with a ‘PROOF’ security 
watermark.
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If the Material that you select for this Item has 10. 
multiple Suppliers, you can select whether or not 
to allow your client the option of selecting which 
Supplier they would like to fulfill the order. 

Delivery Date Amendment will allow your client to 11. 
request an earlier delivery date. When an Order is 
placed, the Purchase Order will go through to the 
Supplier with the newly requested date, your Sup-
plier will have the opportunity to Accept or Decline 
the Order. 

A Job Ticket will usually be sent in plain TXT for-12. 
mat, however, If your supplier is JDF enabled you 
may choose to use JDF formatted tickets.

After your client places an order, a Purchase Order 13. 
is created. This must be sent and accepted for the 
job to progress. Some companies prefer to send 
this manually as a final check, but most prefer this 
to be done automatically as human intervention 
tends to slow the process down. Mtivity recom-
mends applying a Workflow to the Catalog as a 
whole - this can be set to Send and Accept Pur-
chase Orders automatically and saves having to 
make these settings on an individual Item level. A 
Workflow will override the Purchase Order settings 
made at an Item level.  

Its generally a good idea to select your client from 14. 
the Client menu - this makes objects easier to find 
later.

If an item is set to non-active, it does not display 15. 
to your client, this is a handy way of taking an item 
offline if changes need to be made.

Select your Item Pricing to define the Item’s pric-16. 
ing, estimated delivery date, available quantities 
and supplier. See the Pricing section above for 
more information.

Associated Files can be passed on to your clients 17. 
and suppliers. This is usually used for original or 
supporting documents. To do this click the Selec-
tion Tool ( ) and select your files. 

If you wish to associate Metadata with your Item 18. 
you can do so here - see the Metadata section 
below for more information.

Click the Save button to create your Item.19. 

Once your item has been created you can add cus-
tomizations - see the Customizations Guide for more 
information.

A Client’s View of a Make to Order Item

Below is how your client would view a Make to 
Order Item when browsing their Catalog.

NameThumbnail Description Item Code

Lead Time (from the 
Item’s Material)

This is how your client 
orders the Item

Qty and price details 
(from the Item’s Material)

Book Items 
A book item allows you to upload a number of chap-
ters against the Item. Your client can tailor the item to 
include only required chapters. Placing an order will 
compile the book with the selected chapters.

If you would like to enable Book Items for your com-
pany, please contact Mtivity Support.

Creating a Book Item

Location: Admin > Catalogs > Items

Click New Book Item in the Tools menu on the 1. 
right hand side. This will open the new Book Item 
screen.

The Name will appear to your clients so call it 2. 
something that they will understand.

If you have a unique code for this Item you can 3. 
enter it in the Item Code field. Your clients can 
search on this code too.

If you want to add more information about this 4. 
Item you can do so in the Description field - your 
clients will be able to see and search on this.

Specify the fields Revision Number, Release Num-5. 
ber and Release Date if any. 
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The Preview setting allows your client to click the 6. 
thumbnail to view a PDF of the Book’s chapters.

You can select or upload a Thumbnail  image by 7. 
clicking the Change link. 

You can specify if you want printing on one side 8. 
or both sides of  the book’s pages. Furthermore, 
if two sided is chosen, you can specify if chapters 
need to begin on an odd page. This will mean 
that a blank page will be inserted if necessary to 
ensure that chapters will start on an odd page. 

When your client is placing their order for this Item 9. 
you can set whether they can upload a file, this 
can be used for a variety of purposes such as a 
translation file or list of addresses to send the out-
put to. The Send to Supplier checkbox will ensure 
that the vendor also has access to the uploaded 
file.

You can select whether to allow your clients to 10. 
download the customized PDF, if so, you can se-
lect further Adobe Acrobat security settings such 
as allowing editing, printing, password protection, 
or stamping the PDF with a ‘PROOF’ security 
watermark.

If the Material that you select for this Item has 11. 
multiple Suppliers, you can select whether or not 
to allow your client the option of selecting which 
Supplier they would like to fulfill the order. 

Delivery Date Amendment will allow your client to 12. 
request an earlier delivery date. When an Order is 
placed, the Purchase Order will go through to the 
Supplier with the newly requested date, your Sup-
plier will have the opportunity to Accept or Decline 
the Order. 

A Job Ticket will usually be sent in plain TXT for-13. 
mat, however, If your supplier is JDF enabled you 
may choose to use JDF formatted tickets.

After your client places an order, a Purchase Order 14. 
is created. This must be sent and accepted for the 
job to progress. Some companies prefer to send 
this manually as a final check, but most prefer this 
to be done automatically as human intervention 
tends to slow the process down. Mtivity recom-
mends applying a Workflow to the Catalog as a 
whole - this can be set to Send and Accept Pur-
chase Orders automatically and saves having to 
make these settings on an individual Item level. A 
Workflow will override the Purchase Order settings 

made at an Item level. 

It’s generally a good idea to select your client from 15. 
the Client menu - this makes objects easier to find 
later.

If an Item is set to non-active, it does not display 16. 
to your client, this is a handy way of taking an item 
offline if changes need to be made.

Click the Select Chapters button to add a number 17. 
of PDFs to the Book Item. The selected files for 
Book Items must all be the same page size.  After 
selecting your Chapters, you can specify if one 
is required by clicking the Mandatory checkbox 
to the right of the Chapter’s name. A Chapter 
marked as mandatory cannot be excluded by the 
end user when ordering the Book. To re-order the 
selected Chapters, click the Set Display Order 
button. For more information on Chapters see 
Grouping Chapters below.

Select your Item Pricing to define the Item’s pric-18. 
ing, estimated delivery date, available quantities 
and supplier. See the Pricing section above for 
more information.

Associated Files can be passed on to your clients 19. 
and suppliers. This is usually used for original or 
supporting documents. To do this click the Selec-
tion Tool ( ) and select your files. 

If you wish to associate Metadata with your Item 20. 
you can do so here - see the Metadata section 
below for more information.

Click the Save button to create your Book Item.21. 

Once your item has been created you can add cus-
tomizations - see the Customizations Guide for more 
information.
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A Client’s View of a Book Item

Below is how your client would view a Book 
Item when browsing their Catalog.

NameThumbnail Description Item Code
Lead Time (from the Item’s Material)

This is how your client 
orders the Item

Qty and price details 
come from the Item’s 
Materials

This is how your client 
selects chapters

Grouping Chapters

Location: Admin > Catalogs > Items

You can split the selected Chapters into Groups to 
ensure there is a logical separation of Chapters. To do 
this, select the Chapters you wish to group using the 
checkbox to the left of its name, then click the ‘New 
Group’ button. The Group name will appear to your 
client. Within each group you can also specify if there 
is a minimum or maximum number of chapters that 
must be ordered from that group. 

Rather than selecting Chapters first and then adding 
them to a Group, you may find it quicker to do this in 
one step. If you just click the New Group button with-
out selecting Chapters first, you will be able to select 
the Files you wish to import by clicking the Select 
Chapters link.

To add Chapters to an already created Group, select 
the Chapters you wish to add, then click the Edit link 
next to the Group that you are adding the Chapter to.

A Client’s View of Chapter Groups

Below is how your client would make Chapter 
selections. In this example Cover is mandatory, 
it and Importance of Posture, are not in a Group. 
Units is a Group containing The Inner Unit, The 
Outer Unit, and Posture. There is another Group 
named Related Book Review that contains the 
Firm and Flatten Your Abs section. The client 
opens the selection tool by clicking the Chapter 
Selection Available box above.

  

Customizations and Book Items

Location: Admin > Catalogs > Items

Customizations essentially work the same way as 
with Make to Order Items, however there is one very 
important difference: customizations are applied at the 
file level, meaning that if the file is used across Items, 
the customization that were defined on the first Item 
would be inherited by the others. A good example 
of this is a cover: you may have a series of training 
manuals that all use the same cover template with 
customized titles or course information. Rather than 
having to define the customizations multiple times 
across the manuals, you only need to do so once and 
all instances of that cover will use the same customi-
zations.

Customizations are added to Book Items on the view 
screen, using the links to the right of the Chapter 
names.

See the Customizations Guide for more information.
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Renaming Chapters

Location: Admin > Catalogs > Files

A Chapter’s name is taken directly from it’s PDF file. 
To change it’s name you should edit the PDF’s name 
that it is associated with. This can be accomplished 
in either the Files area, or for bulk updates use File 
Import in the Data Management area.  

Setting Chapter Selection Permissions

Location: Admin > Catalogs > Publish

Book Items have an extra set of permissions which al-
low you to set whether your client can select chapters 
or not. When the client can’t select chapters, they will 
not see the tool to do so, and their order will always 
be for the whole book. 

See the Publishing a Catalog With Book Items section  
for information on setting chapter selection permis-
sions. 

Metadata 
Metadata describes further information about an Item 
and its contents. For example, a Postcard may con-
tain Metadata that details it’s finishing, regional infor-
mation, sizing, campaign details etc. Your clients will 
be able to search and filter on any Metadata tags that 
have been associated with any Items in their Catalog.

In Mtivity, this information is created using a Metadata 
List, the list contains a number of tags that may then 
be associated with an Item.

Creating a Metadata List

Location: Admin > Catalogs > Lists

Click New in the Tools menu on the right hand 1. 
side. This will open the New List screen.

Give the List a name, this may appear to your 2. 
clients so should be something descriptive such 
as Size or Region. 

The Description is just for your reference and will 3. 
not appear to your clients.

Metadata should be selected from the Type menu.4. 

If your list is to be associated with a certain client, 5. 
its good practice to select them from the Client 
Menu.

Before Metadata Tags can be added to your List, 6. 
it needs to be saved, so click the Save button. 

Adding Items to a Metadata List

Location: Admin > Catalogs > Lists

Think of your List as a container or folder, now that its 
created Tags (Items) may be added to it. 

Click Add Item in the Tools menu on the right 1. 
hand side. 

You simply need to enter the tag in the Name field.2. 

Generally you will want to create multiple tags 3. 
for the list, so its best to click the Save as New 
button. This will save the entered text and immedi-
ately allow you to enter another Tag.

Associating Metadata Tags to an Item

Location: Admin > Catalogs > Items

You associate Metadata with an Item by Editing the 
Item (or whilst creating a new Item).

In the Metadata table near the foot of the page, 1. 
click the Select Metadata icon ( ). This will open 
the Metadata Selection Tool
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You can select the tags you wish to associate with 2. 
the Item by double clicking them or using the ar-
row buttons to move them across to the right.

Once you have made your selection, click the OK 3. 
button to associate the Tags to the Item.

Navigating a Catalog

The quickest way to locate an Item in the Cata-
log Admin area is to perform a search from the 
Items list page.

However, rather than locating Items from the list 
page, it may be easier to find them using the 
tree structure menu of a Catalog. Use this to 
navigate through the Catalog by expanding fold-
ers and clicking on the appropriate icon. When 
you click on a Item you will be taken directly to 
it’s specific details page. You can find this func-
tionality on the Catalog’s details page using the 
arrow icon to the left of the Catalog’s name.
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Putting It All Together
Creating & Publishing Your Catalog

A Catalog is a collection or grouping of items, usu-
ally marketing pieces, available for print that you wish 
to make available to a client. Clients can browse and 
order Items from the Catalog. 

The structure of a Catalog can be very fluid, accord-
ing to the business needs of your company. A Catalog 
can split into various categories, each of these may 
hold further sub-categories. The actual Items to be 
ordered should be included in these categories. 

Example Catalog Structure

In this example Books is the Catalog, it contains 
three Categories - Fiction, Foreign Languages 
and Poetry. Fiction and Poetry each contain 
two Items, but Foreign Languages contains two 
Sub-Categories, each containing two Items.

Foreign
Languages

German Spanish

BOOKS

Fiction Poetry

Item Item Item Item

Item Item Item Item

Mtivity recommends that you spend some time plan-
ning a logical structure for your Catalog.

It is usually more efficient to build a Catalog from the 
bottom up; first creating Items, then the Categories to 
hold these items, and finally the Catalog itself which 
will ultimately contain  these Categories. Once you 
have built your entire Catalog, you can make it avail-
able to your client by publishing. Clients can then view 
and place orders for the Items within that Catalog. 

Categories
A Category is a folder or container within a Catalog, 
Items must be placed inside a Category in order to be 
viewed and ordered by your Clients. 

Creating a Category

Location: Admin > Campaigns > Categories

Click New Category in the Tools menu on the 1. 
right hand side. This will open the New Category  
screen. 

Specify a Name for the Category, this will display 2. 
to your Client 

Provide a Description if further information is 3. 
needed, this will display to your Client.

Select a Thumbnail. This will be shown to your Cli-4. 
ent along with the Name and Description.

Select a client: As mentioned in the Catalogs, 5. 
client field is used mainly for searching for the 
object. 

Display Template lets you choose if you want to 6. 
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display the Category in the standard Mtivity format 
or whether you want to customise the look and 
feel of the pages yourself. There are two options 
for templates; Default and Two Row. 

Default will display the category to the end user in 
standard Mtivity layout. 

Two Row will reveal several new HTML editor 
boxes which become available for populating. 
Using these fields a “Mood Page” may be created 
for the Category. These will be discussed in the 
Advanced Templates section below. 

Adding Items to a Category

Location: Admin > Campaigns > Categories

From you Category page, click the Add Item Tool. 1. 
This will open the Select Items window.

 Move the Items you wish to select to the right 2. 
hand panel either by double clicking or using the 
arrow buttons.

You may re-order the selected Items by using the 3. 
Up and Down buttons on the right.

Once you have selected the Items you wish to ap-4. 
pear in your Category, click the OK button.

Adding Sub Categories to a Category

Location: Admin > Campaigns > Categories

Sub Categories can be created within categories to 
form a tree like structure. 

From a Category’s detail page, click the Manage 1. 
Sub Categories Tool. This will open up a window 
which you can use to add/remove Sub Catego-
ries. 

Select the Categories you want to include as Sub 2. 
Categories by moving them to the right hand side 
of the frame. 

You can use the Up and Down buttons to order 3. 
the Sub Categories. 

Once you have selected the Sub Categories you 4. 
wish to appear in your Category, click the OK but-
ton.

Catalogs
A Catalog can be thought of as the top level folder 
that contains all the Categories and Items. 

Creating a Catalog

Location: Admin > Catalogs > Catalogs

Click New Catalog in the Tools menu on the right 1. 
hand side. This will open the New Campaign 
screen

Specify a name for the campaign. 2. 

It is generally a good idea to select your Client 3. 
from the menu, this makes the object easier to 
find later. 

If you want to add some more information about 4. 
the campaign, you can do so in the Description 
field - your clients will be able to see this.

You can select a Thumbnail for the Catalog. This 5. 
will appear to your Client against the name but 
only if multiple Catalogs are published - if only 
one Catalog is published to the Client they will be 
taken there directly. 

Select a Job Manager for the Catalog. When 6. 
the Client places an order for any Items in the 
Catalog, a Job will be created in the background 
to process the Order. The Job Manager will be 
responsible for the Order’s completion. 

Direct Client Purchasing allows the Supplier to 7. 
communicate directly with the Client. When an 
Order is placed, the PO is sent to the Supplier 
from the Client and any further communication is 
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handled directly between the Client and Supplier 
without having to go through the Job Manager. 

Order fields define which fields you need to cap-8. 
ture when the Client places an Order. You can 
also specify whether these fields are mandatory 
(required) or optional.

Job Type: When an Order is placed, a Job is cre-9. 
ated by Mtivity in the background. The Job Type is 
generally used for reporting purposes. 

Selecting a Workflow will ensure that your Jobs 10. 
progress in a timely manner. These workflow steps 
mainly govern a Job Status change at the end of 
each step in the Order process. You can select 
any one workflow for the Catalog. Mtivity recom-
mends using a Workflow to at least automatically 
send and accept the Purchase Order that is cre-
ated when an Order is placed - if not set, this is a 
common reason for Jobs to stall. 

If the Display Terms option is selected, it will al-11. 
low you to enter any Terms & Conditions or SLAs 
that you will have with the client. These can either 
be entered as text, or uploaded as a file.  Using 
the field Accept Terms options, you can define 
whether the Client is obliged to accept the Terms 
& Conditions before placing their Order. 

Upload Order Request allows the Client to send 12. 
a file and message to the catalog manager from 
within the Catalog. This can be used for things 
such as the Client uploading a media schedule, or 
requests for new Items in the Catalog. The Order 
Request Image displays beneath the Order Basket 
and serves as the link that opens the function. 

Display Template lets you choose if you want your 13. 
Catalog to be displayed in the standard Mtivity 
format or whether you want to customize the look 
and feel of the pages yourself. There are two op-
tions: 

Default will display the campaign to the end user 
in the standard Mtivity layout. 

If Two Column is selected several new HTML 
editor boxes will become available for populat-
ing. Using these fields a “Landing Page” may be 
created for the Catalog. These will be discussed in 
the Advanced Templates section. 

Adding Categories to a Catalog

Location: Admin > Catalogs > Catalogs

From you Catalog page, click the Manage Cat-1. 
egories Tool. This will open the Select Categories 
window.

Move the Categories you wish to select to the 2. 
right hand panel either by double clicking or using 
the arrow buttons. All Sub Categories and Items 
contained within a Category are moved too.

You may re-order the selected Items by using the 3. 
Up and Down buttons on the right.

Once you have selected the Categories you wish 4. 
to appear in your Catalog, click the OK button.

Publishing a Catalog

Location: Admin > Catalogs > Catalogs

In order for your Clients to access a Catalog, it must 
first be published to them. It is a good idea to also 
publish the Catalog to yourself to check that every-
thing appears how you intend. If your Client company 
is not yet created in Mtivity, you will have to set that 
up before you can publish. Details to do this can be 
found in section Setting up Client & Supplier Compa-
nies.

From you Catalog page, click the Publish Tool. 1. 
This will open the Publish Catalog window.
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You can publish Catalogs to one or more compa-2. 
nies, which means that it will be available to all us-
ers of the company, to do this select the All Depts, 
All Users row and move it to the right.

You can use the Company and Display filter 3. 
menus to publish it to only selected departments 
of companies. This will allow only users of those 
departments to access the Catalog. You can even 
publish it to individual users in a company by se-
lecting Users from the Display menu. 

You can define how long the Catalog will remain 4. 
published by specifying a Expiry date. Simply 
leave this blank if you intend the Catalog to be 
published permanently.  

Click the OK button to Publish your Catalog.5. 

Making Changes to a Published Catalog

There is no need to “republish” a Catalog after 
making amendments or additions. Any changes 
made to a published Catalog (including anything 
within it) are updated in real-time. So for exam-
ple, if a new Item is added to a Category within 
a Published Catalog, it will be available to your 
Clients immediately.

Amending Publishing Details

Location: Admin > Catalogs > Catalogs

On the Catalog Details page, a Publishing Log 1. 
appears displaying details of when and to who the 
Catalog has been published to.

You can unpublish the Catalog by clicking the Un-2. 
publish icon ( ) to the right of the entry. This will 
remove the Catalog from your Client’s view. 

To make changes such as removing or adding De-3. 
partments and or Users, click the date on the left 
to re-open the Publish window.

Catalog Orders Message
You can specify a message which appears on the 
order screen of each client company. This message 
can be used to specify any support or contact details 
which the client can use if they have queries about 
their order.

Creating an Orders Message

Location: Admin > Relationships > Account Details

An Orders message is created against a client com-
pany, if you have multiple clients each may have a 
different message defined.

From the Admin > Relationships tab, click on the 1. 
client that you wish to create a message for. This 
will open the Account Details screen.

Click the Edit button at the top of the page. This 2. 
will open the Edit Account Details screen 

Near the bottom of the page is the Orders Mes-3. 
sage input area. You may use HTML tags to 
format your message.

Click the Save button to create your message.4. 

Viewing an Orders Message

Location: Dashboard > Orders > Order Details

Your Orders Message will appear beneath the Items 
on the Order Details screens for the specified clients. 
All users from the chosen company will see the same 
message.
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Advanced Templates
Mtivity allows you to select specialised templates for 
Catalogs and Categories using “Two Column” and 
“Two Row” templates respectively. 

The Two Column template for Catalogs has four input 
boxes for HTML input.

A good primer on HTML can be found here:  http://
www.w3schools.com/html/html_primary.asp 

A Client’s View of a Catalog

Below is how your Client would view a Catalog 
that uses an advanced template.

BannerWelcome

Video/Image Categories
What’s New is not 
used in this example, 
but it appears above 
the Categories

Banner•	 : Using HTML you can create a Banner 
that will appear on the Top of the “Landing Page.” 
The image that is used in the Banner has to be 
hosted (on a web server) and the HTML code 
must reference this image and its location. 

Video / Image•	 : An image or a video file that is 
hosted on a web server can be displayed using 
HTML code. The optimized resolution for screens 
is 1024 x 768, anything below this will start to 
degrade. The optimal Flash file dimensions should 
be 628 Height and 358 Width (pixels) 

Welcome•	 : The Welcome message is displayed 
below the Banner on the “Landing Page”. It is 
important to note that there is great flexibility to 
what can be displayed. You may decide to provide 

links within the code or use different flash files in 
the various positions. 

What’s New•	 : Again using HTML code you have 
the ability to enter in details of any New informa-
tion that you wish to highlight to the client user. 
The “What’s New” section appears on the right 
hand side of the “Landing Page” above the list of 
Categories.

The Two Row template for Categories has three input 
boxes allowing HTML input. Like the Catalog area, 
because you are entering HTML code, you are af-
forded a great deal of freedom in what purpose you 
actually use the below areas for. A Category using this 
template should only include Sub Categories - not 
Items.

Customer Journey: Using HTML code an image 
that is hosted on a web server may be pulled into the 
“Mood Screen” 

Mood Video: Again, using HTML a hosted flash video 
may be shown on the Mood Screen to set the tone of 
items within the sub categories. The video might be 
used to display timelines, or updates to the end users 

Product Guidelines: Using HTML code a link can be 
created that will take the user to a PDF with detailed 
guidelines on how the items should be ordered or the 
campaign run

A Client’s View of a Category

Below is how your Client would view a Category 
that uses an advanced template. Please note: 
when using this template your category should 
only contain Sub Categories, not Items.

Product GuidelinesMood Video

Customer Journey Sub Categories
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Users & Companies
Setting Up Your Clients & Suppliers

To set up a new Company, you will have to first create 
a new Contact in Mtivity, on doing so, the new Com-
pany will be created and the Contact will be added to 
the new Company as the administrator. 

Note: If you are creating a Client Company to publish 
your Catalog to, it is most likely that you also want to 
define the branding for the Client and bulk upload us-
ers. In this case, Mtivity recommends that you register 
yourself as an administrator in the Client Company 
and retain the email address you used to register. 
Since Mtivity allows an email to be used only in one 
company, what users typically do is register a different 
email in gmail/hotmail etc, and use that email to invite 
themselves as an administrator in the Client Company. 

Companies
Client and supplier companies are created in the 
same manner in the Address Book section.

Creating a New Company

Location: Address Book 

In the address book, you can see a list of all your 1. 
contacts in Mtivity. This page also shows whether 
your contacts are signed-up to Mtivity. 

Click the New Tool on the right hand side, this will 2. 
open the New Contact screen.

First Name, Last Name and email id are the man-3. 
datory fields to create a new contact

Ensure that Invite Contact checkbox is ticked, so 4. 
that the user can be invited to sign up to Mtivity.  
 
Note: If you want to brand the client company, 
you may want to enter  an email address  that you 
have access to, and that has not been used in 
Mtivity (see note above). 

When you click on Next, the second step will be 5. 
to select account to add user to. Here you should 
select the option – New account. 

This will take you to the New Account page, 6. 
where you can specify the Account Name for the 
client company and the address. 

You can then invite the user to sign up to Mtiv-7. 
ity. Use the Message box if you would like to add 
a  personal note to the new user. Click Invite to 
finish the process, this will send an invitation email 
which contains a link to the system and a tempo-
rary username and password. 

Once the user accepts the invitation, the client com-
pany will be created and the first user that signs up 
will have administrator rights in the company. 
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Users
There are two methods of adding users to Mtivity. 
The manual process will send out an invitation which 
needs to be accepted by the invited user. The Bulk 
import of users bypasses the invitation process - us-
ers are directly added. 

Manually Adding Users

Location: Address Book

Users can be added to a Company from the Ad-1. 
dress Book by clicking the New Tool (as described 
above) 

Enter the User’s details and click Next2. 

In step 2, choose either your own Company or 3. 
select the Client or Supplier Company you wish to 
add the user to. Click Next.

You can then invite the user to sign up to Mtiv-4. 
ity. Use the Message box if you would like to add 
a  personal note to the new user. Click Invite to 
finish the process, this will send an invitation email 
which contains a link to the system and a tempo-
rary username and password. 

Bulk Import of Users

Location: Admin > Data Management

If you wish to import users to a new company contact 
Mtivity Support to turn this function on for you.

To import users you need to enter their details 1. 
into a CSV file and import the file into Mtivity. The 
template for the CSV can be obtained by export-
ing users - this will export a CSV file with existing 
users in the Company. 

Populate the columns of the CSV with the users 2. 
to be uploaded. You should leave the ID column 
blank for the New users - this will be assigned by 
the system. The most important columns are the 
First Name, Last Name, Password and Email Ad-
dress.

When you’re done, import this CSV into Mtivity. 3. 
The system will check for errors before importing.

Note: Importing users allows you to set everything 
up before users access the system, therefore Mtivity 
does not send notifications - you need to inform new 
users of their access details manually.

Setting up Approvals 

Location: Admin > Users

You might want to set up an Approval process for 
users of the Client Company.  A maximum limit can be 
set for a user to place a single order. If the order ex-
ceeds that budget, then the order would require Ap-
proval. If you want every order placed to go through 
an Approval process, the limit should simply be set to 
zero.  

Approvals can only be set up for users in your own 
company, so if you are setting up approvals on behalf 
of a Client you will need to be logged in as an Admin-
istrator in their Company. 

From the Users listing page, click on the User that 1. 
you wish to set up an Approval for.

Click the Edit Tool on the right hand side.2. 

Near the foot of the page on the left hand side you 3. 
will see the Purchase Approval area.

Use the checkbox to select Required 4. 

Specify the amount over which approval should 5. 
be obtained. Enter 0 to ensure that all orders must 
be approved.

You should also specify who the Approver is. This 6. 
person will receive email notification with a link to 
the order that needs to be approved. There they 
will be able to Approve or Reject the Order.  

Click the Save button to save your changes.7. 

Budget Compliance

Location: Admin > Users

Budget can be allocated for a user to spend in a defi-
nite period – typically a quarter. Every Order placed by 
the user will use funds from the budget, and will disal-
low purchase if the user has used up all their funds. 
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Budget can only be set up for users in your own com-
pany, so if you are setting up a Budget on behalf of a 
Client you will need to be logged in as an Administra-
tor in their Company. 

From the Users listing page, click on the User that 1. 
you wish to set up a Budget for.

Click the Edit Tool on the right hand side.2. 

Near the foot of the page on the right hand side 3. 
you will see the Catalog Budget Compliance area.

Use the checkbox to select Required 4. 

Click the New Budget Allocation link to add funds, 5. 
this will be the budget that user will be working 
with. 

You can add or subtract funds to an existing Bud-6. 
get using Edit funds. 

Click the Save button to save your changes. 7. 

Any order placed by the user, will use funds from this 
Budget. The spend amount and remaining budget 
available for the user will be displayed in the user 
details. The user themselves can see their remaining 
Budget in the area above their Shopping Cart. 

When its end of a quarter, you can allocate a new 
Budget to the user. This will end the existing Budget, 
and create a new Budget for the user to work with. 

Branding
With an administrator login, you can brand your client 
company, so that users logging in will be able to enjoy 
a customized look and feel.  

The name of the ‘Catalog’ tab may be changed to suit 
your or your Client’s purposes - please contact Mtivity 
Support to make this change.

Setting a Company’s Branding

Location: Admin > General Settings

This page will show the default settings that Mtivity 
populates for any company. You can edit these to suit 
your needs. 

You can do this by using the Edit Tool on the tool-1. 
bar in the right hand side. 

The Style section is what you are most likely to 2. 
change for the client company to give it a person-
alized look and feel.  

Style allows you to change the color scheme. 3. 
Click the Selection Tool ( ) to preview the avail-
able styles. When you have chosen your style, 
select OK for it to be applied. The new style will 
be shown immediately after you click Save on the 
Edit Company Settings page. If you would like a 
unique style created for your organization, please 
contact Mtivity Support for a quote.

You can upload a company logo as a Header 4. 
Image. For this select Custom from the Applica-
tion Header options, and then upload your logo. 
Images should be in gif, jpeg, or png format. 
 
If your logo is to be aligned left, center or right 
Mtivity recommends a height of up to 60 pixels. 
The height of the header area will expand to the 
height of your logo, so if its too tall the navigation 
will be pushed down the page. You will have the 
entire width of the screen available in the header 
area. 
 
If your logo is to be displayed inline, Mtivity rec-
ommends a width smaller than 110 pixels and a 
height of 80 pixels.

In conjunction with choosing a image for your 5. 
header, you can also select a Background Color. 
This will apply the selected color to the banner 
area above the Section Navigation. The height of 
this area is determined by the height of the Head-
er Image you upload. The color should be entered 
in Hex format. (To convert an RGB color to Hex, 
see www.easycalculation.com/rgb-coder.php)

Image Alignment determines the position within 6. 
the header area you wish your logo to appear. 
Left, Center and Right will place your logo in the 
banner area above the Section Navigation. Inline 
will place your logo to the left of the navigation. 
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Branding Examples

This is an inline Logo with a size of W:109px H:82px.

In this example the logo has been aligned to the center, its 
size is W:49px H: 60px. 

This example has a background color of gray, with a logo 
set to align left. You can see from the background color 
that the whole header area above the section navigation is 
available.

Creating a Custom Login Page

An HTML login page may be created for access to 
Mtivity. This can be hosted on a client server which 
will allow users to access the system without going to 
www.mtivity.com 

Custom Login Page

Note: If needed, Mtivity can host your custom login 
page for you.

Create a standard HTML page and include a form 1. 
for users to enter their username and password. 
 
The following code is the minimum that is needed 
for the form to submit the user’s details to Mtivity 
for authentication. 

<form action=”https://www.mtivity.com/
apps/DcLogin.csp” id=”Login” name=”Login” 
method=”post”> 

<input type=”text” name=”username” 
id=”username” /> 

<input type=”password” name=”password” 
id=”password” /> 

<input type=”submit” name=”Login” id=”Login” 
value=”Login” /> 

</form>

You can test your HTML page by logging in with 2. 
any username and password.

Once you have a URL for your hosted page you 3. 
should enter this in Admin > General Settings > 
Logout Page. This will ensure that when your us-
ers log out or are timed out they will return to your 
custom login page rather than www.mtivity.com


